
CHAPTER 6

Module: Creating Vector Data

Creating maps using existing data is just the beginning. In this module, you’ll learn how to

modify existing vector data and create new datasets entirely.

6.1 Lesson: Creating a New Vector Dataset

The data that you use has to come from somewhere. For most common applications, the data

exists already; but the more particular and specialized the project, the less likely it is that the

data will already be available. In such cases, you’ll need to create your own new data.

The goal for this lesson: To create a new vector dataset.

6.1.1 Follow along: The Layer Creation Dialog

Before you can add new vector data, you need a vector dataset to add it to. In our case, you’ll

begin by creating new data entirely, rather than editing an existing dataset. Therefore, you’ll

need to define your own new dataset first.

You’ll need to open the New Vector Layer dialog that will allow you to define a new layer.

• Navigate to and click on the menu entry Layer → New → New Shapefile Layer.

You’ll be presented with the following dialog:
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It’s important to decide which kind of dataset you want at this stage. Each different vector layer

type is “built differently” in the background, so once you’ve created the layer, you can’t change

its type.

For the next exercise, we’re going to be creating new features which describe areas. For such

features, you’ll need to create a polygon dataset.

• Click on the Polygon radio button:
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This has no impact on the rest of the dialog, but it will cause the correct type of geometry to be

used when the vector dataset is created.

The next field allows you to specify the Coordinate Reference System, or CRS. A CRS specifies

how to describe a point on Earth in terms of coordinates, and because there are many different

ways to do this, there are many different CRSs. The CRS of this project is WGS84, so it’s

already correct by default:

Next there is a collection of fields grouped under New attribute. By default, a new layer has

only one attribute, the id field (which you should see in the Attributes list) below. However, in

order for the data you create to be useful, you actually need to say something about the features

you’ll be creating in this new layer! For our current purposes, it will be enough to add one field

called name.

• Replicate the setup below, then click the Add to attributes list button:

• Check that your dialog now looks like this:
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• Click OK. A save dialog will appear.

• Navigate to the exercise_data directory.

• Save your new layer as school_property.shp.

The new layer should appear in your Layers list.
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6.1.2 Follow along: Data sources

When you create new data, it obviously has to be about objects that really exist on the ground.

Therefore, you’ll need to get your information from somewhere.

There are many different ways to obtain data about objects. For example, you could use a GPS

to capture points in the real world, then import the data into QGS afterwards. Or you could

survey points using a theodolite, and enter the coordinates manually to create new features. Or

you could use the digitizing process to trace objects off of remote sensing data, such as satellite

imagery or aerial photography.

For our example, you’ll be using the digitizing approach. Sample raster datasets are provided,

so you’ll need to import them as necessary.

• Click on the Add Raster Layer button:

• Navigate to exercise_data/raster/.

• Select the file 3420C_2010_327_RGB_LATLNG.tif.

• Click Open. An image will load into your map.

• Find the new image in the Layers list.

• Click and drag it to the bottom of the list so that you can still see your other layers.

• Find and zoom to this area:
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You’ll be digitizing these three fields:
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• Hide all the layers except the raster and the school_property layer.

In order to begin digitizing, you’ll need to enter edit mode. GIS software commonly requires

this to prevent you from accidentally editing or deleting important data. Edit mode is switched

on or off individually for each layer.

To enter edit mode for the school_property layer:

• Click on the layer in the Layer list to select it. (Make very sure that the correct layer is

selected, otherwise you’ll edit the wrong layer!)

• Click on the Toggle Editing button:

If you can’t find this button, check that the Digitizing toolbar is enabled. There should be a

check mark next to the View → Toolbars → Digitizing menu entry.

As soon as you are in edit mode, you’ll see the digitizing tools are now active:
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From left to right on the image above, they are:

• Toggle Edit: activates / deactivates edit mode.

• Save Edits: saves changes made to the layer.

• Add Feature: start digitizing a new feature.

• Move Feature(s): move an entire feature around.

• Node Tool: move only one part of a feature.

• Delete Selected: delete the selected feature (only active if a feature is selected).

• Cut Features: cut the selected feature (only active if a feature is selected).

• Copy Features: copy the selected feature (only active if a feature is selected).

• Paste Features: paste a cut or copied feature back into the map (only active if a feature

has been cut or copied).

You want to add a new feature.

• Click on the Add Feature button now to begin digitizing right away!

You’ll notice that your mouse cursor has become a crosshair. This allows you to more accu-

rately place the points you’ll be digitizing. Remember that even as you’re using the digitizing

tool, you can zoom in and out on your map by rolling the mouse wheel, and you can pan around

by holding down the mouse wheel and dragging around in the map.

The first feature you’ll be digitizing is the athletics field:
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• Start digitizing by clicking on a point somewhere along the edge of the field.

• Place more points by clicking further along the edge, until the shape you’re drawing

completely covers the field.

• To place your last point, right-click where you want it to be. This will finalize the feature

and show you the Attributes dialog.

• Fill in the values as below:
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• Click OK and you’ve created a new feature!

Remember, if you’ve made a mistake while digitizing a feature, you can always edit it after

you’re done creating it. If you’ve made a mistake, continue digitizing until you’re done creating

the feature as above. Then:

• Select the feature with the Select Single Feature tool:

You can use:
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• the Move Feature(s) tool to move the entire feature,

• the Node Tool to move only one point where you may have misclicked,

• Delete Selected to get rid of the feature entirely so you can try again, and

• the Edit → Undo menu item or the ctrl + z keyboard shortcut to undo mistakes.

6.1.3 Try yourself...

• Digitize the school itself and the upper field. Use this image to assist you:

Remember that each new feature needs to have a unique id value!

Note: When you’re done adding features to a layer, remember to save your edits and then exit
edit mode.
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6.1.4 Try yourself...

• Create a new line feature called river.shp with attributes id and type. (Use the

approach above to guide you.)

• Digitize the river that runs through town.

Start where the sandy riverbanks first become visible:

And stop when our river joins another river:
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It’s not always clear where the river runs. In such cases, use your better judgment and estimate

where the river goes. Remember that you’re capturing the river at a large scale, so try to follow

it in detail. Take some time, don’t let the line become too straight or make the corners too

sharp!

When creating the feature, give it the type attribute value of “stream”.

Check your results

6.1.5 In conclusion

Now you know how to create features! This course doesn’t cover adding point features, be-

cause that’s not really necessary once you’ve worked with more complicated features (lines

and polygons). It works exactly the same, except that you only click once where you want the

point to be, give it attributes as usual, and then the feature is created.

Knowing how to digitize is important because it’s a very common activity in GIS programs.
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6.1.6 What’s next?

Features in a GIS layer aren’t just pictures, but objects in space. For example, adjacent polygons

know where they are in relation to one another. This is called topology. In the next lesson you’ll

see an example of why this can be useful.

6.2 Lesson: Feature Topology

Topology is a useful aspect of vector data layers, because it minimizes errors such as overlap

or gaps.

For example: if two features share a border, and you edit the border using topology, then you

won’t need to edit first one feature, then another, and carefully line up the borders so that they

match. Instead, you can edit their shared border and both features will change at the same time.

The goal for this lesson: To understand topology using examples.

6.2.1 Follow along: Snapping

To make topological editing easier, it’s best if you enable snapping. This will allow your mouse

cursor to snap to other objects while you digitize. To set snapping options:

• Navigate to the menu entry Settings → Snapping Options....

• Set up your Snapping options dialog as shown:

• Ensure that the box in the Avoid Int. column is checked (set to true).

• Click OK to save your changes and leave the dialog.

• Enter edit mode with the rural layer selected.

• Check under View → Toolbars to make sure that your Advanced Digitizing toolbar is

enabled.

• Zoom to this area (enable layers and labels if necessary):
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• Digitize this new (fictional) farm:
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• When prompted, give it an id of 999, but feel free to leave the other values unchanged.

If you’re careful while digitizing and allow the cursor to snap to the vertices of adjoining farms,

you’ll notice that there won’t be any gaps between your new farm and the existing farms adja-

cent to it.

• Note the undo/redo tools in the Advanced Digitizing toolbar:

Those buttons will become your best friends...

6.2.2 Follow along: Closing the Gaps

You’ve probably noticed some large holes in the rural dataset:
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The white gaps among the farms, which are not filled by grey urban areas, represent missing

farms. Let’s say you want to close these gaps. If you were adding features normally, you’d

have to be very accurate to avoid gaps and overlap. In fact, even if you’re very accurate,

without vertex snapping (which you activated above), digitizing features without such errors is

impossible.

However, we have another tool to use for this situation. Since we already have topology en-

abled, it’s possible to very quickly close a hole without even worrying about accuracy, and the

topology will take care of the rest. For example, let’s say you want to digitize a new farm to

close up this gap:
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If you had to do this without help from the topology, you’d be digitizing that for a while. But

at the moment, as per the directions above, you have Avoid Int. (“Avoid Intersections”) enabled

for the rural layer. This tells QGIS to use the topology to prevent overlap. So you can digitize

even a very rough shape:
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(Use an id value of somewhere in the hundreds range to avoid a conflict with existing features.)

But when you select the feature ...
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... you’ll see that QGIS has automatically added all the detailed vertices and made sure that

there was no overlap!

• Try doing this now.

Note: The “Avoid Intersections” option only works to eliminate overlap (intersections). Ob-
viously, if you leave a gap, that will not be filled, because you might not actually want the gap

to be filled!

6.2.3 Try yourself...

• Close the remaining gaps using the approach above, but make sure not to create farms

over urban areas.

• Remember to save your edits, and if necessary, to exit edit mode.

Check your results
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6.2.4 Follow along: Correct topology errors

Topology errors aren’t always immediately visible. Let’s change the rural layer’s symbology

to see some of them.

• Set the symbology for the rural layer to a single (preferably dark) color.

• Set its Transparency slider to 50%.

• You should see results like these:

There are several things to notice here. First, the new farm you added is lighter than the others.

This is because in this dataset, there are several “levels” of farms: large farms and their sub-

divisions were digitized separately. So there is a large farm and its subdivisions resting on top

of each other, which makes the color darker because you’re seeing the lower one through the

upper one. That’s a feature of the dataset, not a problem.

But you can also notice a definite problem: one of the farms is going underneath another one!

Obviously this is a mistake, because in the real world farms don’t overlap, and two farms don’t

share the same subdivision.

Let’s correct this!

• Enter edit mode, if it isn’t active already.

• Select the Node Tool.

• Click on one of the corners of the problematic farm. This will select that farm for editing

and you’ll see all the nodes appear:
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• Click and drag the nodes until they snap into place.
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The topologically correct border looks like this:
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6.2.5 Follow along: Tool: Simplify Feature

This is the Simplify Feature tool:

• Click on it to activate it.

• Click on the new farm you created previously. You’ll be presented with this dialog:
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• Move the slider from side to side and watch what happens:

This allows you to recude the amount of nodes in complex features. However, notice what it

does to the topology! The simplified farm is now no longer touching the adjacent farms as it

should. That’s how you know that this tool is better suited to generalizing stand-alone features.

The advantage is that it provides you with a simple, intuitive interface for generalization, and

allows you to see what the effects would be before you even implement them.

Before you go on, get the farm back in its previous state. Either:

• cancel the Simplify Feature dialog, or

• if you already clicked OK, just undo the last change.
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6.2.6 Try yourself... Tool: Add Ring

This is the Add Ring tool:

It allows you to take a hole out of a feature, as long as the hole is bounded on all side by the

feature. For example, if you’ve digitized the outer boundaries of South Africa and you need to

add a hole for Lesotho, you’d use this tool.

• Try using this tool to create a gap in the middle of your farm.

• Undo the edit when you are done.

Check your results

6.2.7 Try yourself... Tool: Add Part

This is the Add Part tool:

It allows you to create an extra part of the feature, not directly connected to the main feature.

For example, if you’ve digitized the boundaries of mainland South Africa but you haven’t yet

added the Prince Edward Islands, you’d use this tool to create them.

• Try using this tool to add an outlying property to your farm.

• Undo the edit when you are done.

Check your results

6.2.8 Try yourself... Tools: Delete Ring and Delete Part

These are the Delete Ring and Delete Part tools, respectively:

Their functions should be obvious.

• Create new parts and rings as above and delete them to try see how these tools work.

• You need to click close to a node (corner) of a part or ring in order to delete it.
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6.2.9 Follow along: Tool: Reshape Features

This is the Reshape Features tool:

It can add a bump to an existing feature. With this tool selected:

• Click inside your farm.

• Add an extra piece of land.

• Right-click back inside the farm:

The result of the above:
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You can do the opposite, too:

• Click outside the feature.

• Take a bite out of it.

• Right-click outside the farm again:
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The result of the above:
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6.2.10 Try yourself... Tool: Split Features

The Split Features tool is similar to how you took part of the farm away, except that it doesn’t

delete either of the two parts. Instead, it keeps them both.

• Try it and see!

• Undo your edit before continuing with the exercise for the next tool.

6.2.11 Try yourself... Tool: Merge Features

• Find and select these farms:
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• Use the Merge Selected Features and Merge Attributes of Selected Features tools.

• Note the differences.

Check your results

6.2.12 In conclusion

Topology editing is a powerful tool that allows you to create and modify objects quickly and

easily, while ensuring that they remain topologically correct.

6.2.13 What’s next?

Now you know how to digitize the shape of the objects easily, but adding in the attributes is still

a bit of a headache! Next we’ll show you how to use forms so that attribute editing is simpler

and more effective.

6.3 Lesson: Forms

When you add new data via digitizing, you’re presented with a dialog that lets you fill in the

attributes for that feature. However, this dialog is not, by default, very nice to look at. This can

cause a usability problem, especially if you have large datasets to create, or if you want other

people to help you digitize and they find the default forms to be confusing.
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Fortunately, QGIS lets you create your own custom dialogs for a layer. This lesson shows you

how.

The goal for this lesson: To create a form for a layer.

6.3.1 Follow along: Using QGIS’ Form Design Functionality

• Select the streets layer in the Layers list.

• Enter Edit Mode as before.

• Open its Attribute Table.

• Right-click on any cell in the table. A short menu will appear, with the only entry being

Open form.

• Click on it to see the form that QGIS generates for this layer.

Obviously it would be nice to be able to do this while looking at the map, rather than needing

to search for a specific street in the Attribute Table all the time.

• Go to the Settings → Options menu (in the same row as the File menu, etc.).

• In the dialog that appears, select the Map Tools tab.

• Check the Open feature form ... checkbox:

• Close the Settings dialog.

• Select the streets layer in the Layers list.

• Using the Identify tool, click on any street in the map.
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Instead of the normal Identify dialog, you’ll see the now-familiar form instead:

6.3.2 Try yourself... Using the Form to Edit Values

If you are in edit mode, you can use this form to edit a feature’s attributes!

• Activate edit mode.

• Using the Identify tool, click on the main street running through Swellendam:
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• Edit its LANES value to the correct value of 2.

• Save your edits.

• Exit edit mode.

• Open the Attribute Table and see your edit there!

Note that there is more than one road on this map called Voortrekker. The one you edited had

a TYPE of tertiary.

6.3.3 Follow along: Setting Form Field Types

It’s nice to edit things using a form, but you still have to enter everything by hand. Fortunately,

forms have different kinds of so-called “widgets” that allow you to edit data in various different

ways.

• Open the streets layer’s Layer Properties.

• Switch to the Fields tab. You’ll see this:
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• Click on the Line edit button in the same row as LANES and you’ll be given a new dialog.

• In its only dropdown list, set the value to Range:

6.3. Lesson: Forms 139



Quantum GIS Training Manual, Release 1.0

• Set the values to this:
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• Click OK.

• Apply the changes to the Layer Properties.

• Enter edit mode.

• Click on the Identify tool.

• Click on Voortrekker road.

Now instead of entering values manually, you can use the up and down arrows next to the

LANES field to edit its values!

6.3.4 Try yourself...

Set new, more appropriate form widgets for these fields:

• TYPE
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• ONEWAY

Check your results

6.3.5 Try yourself... Creating Test Data

You can also design your own custom form completely from scratch.

• Create a simple point layer with two attributes:

– Name (text)

– Age (text)
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• Capture a couple of points to your new layer using the digitizing tools so that you have a

little data to play with. You should be presented with the default QGIS generated attribute

capture form each time you capture a new point.
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6.3.6 Follow along: Creating a New Form

Now we want to create our own custom form for the attribute data capture phase. To do this,

you need to have Qt4 Designer installed (only needed for the person who creates the forms). It

should be provided as part of your course materials, if you’re using Windows. You may need

to look for it if you’re using another OS. In Ubuntu, do the following in the terminal:

sudo apt-get install qt4-designer

... and it should install automatically. Otherwise, look for it in the Software Center.

• Start Designer by opening its Start Menu entry in Windows (or whatever approach is

appropriate in your OS).

• In the dialog that appears, create a new dialog:
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• Look for the Widget Box along the left of your screen (default). It contains an item called

Line Edit.

• Click and drag this item into your form. This creats a new Line Edit in the form.

• With the new line edit element selected, you’ll see its properties along the side of your

screen (on the right by default):
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• Set its name to Name.

• Using the same approach, create a new spinbox and set its name to Age.

• Add a Label with the text Add a New Person in a bold font (look in the object

properties to find out how to set this). Alternatively, you may want to set the title of

the dialog itself (rather than adding a label).

• Click anywhere in your dialog.

• Find the Lay Out Vertically button (in a toolbar along the top edge of the screen, by

default). This lays out your dialog automatically.

• Set the dialog’s maximum size (in its properties) to 200 (width) by 100 (height).

• Save your new form as exercise_data/forms/add_people.ui.
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• When it’s done saving, you can close the Qt4 Designer program.

6.3.7 Follow along: Associating the Form with Your Layer

• Go back to QGIS.

• Double click the layer in the legend to access its properties.

• Click on the General tab in the Layer Properties dialog.

• Specify the path to your ui file in the Edit UI field.

• Click OK on the Layer Properties dialog.

• Enter edit mode and capture a new point.

• When you do so, you will be presented with your custom dialog (instead of the generic

one that QGIS usually creates).

• If you click on one of your points using the Identify tool, you can now bring up the form

by right clicking in the identify results window and choosing View Feature Form from

the context menu.

• If you are in edit mode for this layer, that context menu will show Edit Feature Form

instead, and you can then adjust the attributes in the new form even after initial capture.

6.3.8 In conclusion

Using forms, you can make life easier for yourself when editing or creating data. By editing

widget types or creating an entirely new form from scratch, you can control the experience

of someone who digitizes new data for that layer, thereby minimizing misunderstandings and

unnecessary errors.

6.3.9 Further reading

If you completed the advanced section above and have knowledge of Python, you may want to

check out this blog entry1 about creating custom feature forms with Python logic, which allows

advanced functions including data validation, autocompletion, etc.

6.3.10 What’s next?

Opening a form on identifying a feature is one of the standard actions that QGIS can perform.

However, you can also direct it to perform custom actions that you define. This is the subject

of the next lesson.

1http://tinyurl.com/6tr42rb
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6.4 Lesson: Actions

Now that you’ve seen a default action in the previous lesson, it’s time to define your own

actions. An action is something that happens when you click on a feature. It can add a lot of

extra functionality to your map, allowing you to retrieve additional information about an object,

for example. Assigning actions can add a whole new dimension to your map!

The goal for this lesson: To learn how to add custom actions.

6.4.1 Follow along: The Actions Tab

• Open the Layer Properties dialog for the rural layer.

• Click on the Actions tab to see its contents.

Seems intimidating! But it doesn’t need to be. Let’s see how it works by adding a new action.

6.4.2 Follow along: Open an Image

Use the school_property layer you created previously. The course materials include photos of

each of the three properties you digitized. What we’re going to do next is to associate each

property with its image. Then we’ll create an action that will open the image for a property

when clicking on the property.

6.4.3 Follow along: Add a Field for Images

The school_property layer has no way to associate an image with a property yet. First we’ll

create a field for this purpose.

• Open the Layer Properties dialog.

• Click on the Fields tab.

• Toggle editing mode:
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• Add a new column:
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• Enter the values below:

• After the field has been created, click on the Line edit button next to the new field.

• Set it up for a File name:
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• Click OK on the Layer Properties dialog.

• Use the Identify tool to click on one of the three features in the school_property layer.

Since you’re still in edit mode, the dialog should be active and look like this:
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• Click on the browse button (the ... next to the image field).

• Select the path for your image. The images are in

exercise_data/school_property_photos/ and are named the same as

the features they should be associated with.

• Click OK.

• Associate all of the images with the correct features using this method.

• Save your edits and exit edit mode.

6.4.4 Follow along: Creating an Action

• Open the Actions form for the school_property layer, as explained above for the rural

layer.

• Enter the words Show Image into the Name field:
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What to do next varies according to your operating system, so choose the appropriate course to

follow:

Windows

• Click on the Type dropdown and choose Open.

Ubuntu Linux

• Under Action, write eog for the Gnome Image Viewer, or write display to use Im-

ageMagick. Remember to put a space after the command!

MacOS

• Click on the Type dropdown and choose Mac.

• Under Action, write open. Remember to put a space after the command!

Continue writing the command

The next part is easy! You want to open the image, and QGIS knows where the image is. All it

needs to do is to tell the Action where the image is.

• Select image from the list:
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• Click the Insert field button. QGIS will add the phrase [% "image" %] in the Action

field.

• Click the Add to action list button.

• Click OK on the Layer Properties dialog.

Now to test the new action!

• Click on the school_property layer in the Layers list so that it is highlighted.

• Find the Run feature action button (on the same toolbar as the Open Attribute Table

button):

• Click on the down arrow to the right of this button. There’s only one action defined for

this layer so far, which is the one you just created.

• Click the button itself to activate the tool.

• Using this tool, click on any of the three school properties.
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• The image for that property will now open. Congratulations!

6.4.5 Follow along: Searching the Internet

Let’s say we’re looking at the map and want to know more about the area that a farm is in.

Suppose you know nothing of the area in question and want to find general information about

it. Your first impulse, considering that you’re using a computer right now, would probably be

to Google the name of the area. So let’s tell QGIS to do that automatically for us!

• Open the attribute table for the rural layer (you may need to close Layer Properties first).

There are several fields with names of the area that the farms are in, but many of them contain

some rather strange names. The one field that contains names that are easy to search for on

Google is the SGADMIN field. So we’ll be using that field for our searches.

• Close the attribute table.

• Go back to Actions in Layer Properties.

• In the field Action Properties → Name, write Google Search.

What to do next varies according to your operating system, so choose the appropriate course to

follow:

Windows

• Under Type, choose Open. This will tell Windows to open an Internet address in your

default browser, such as Internet Explorer.

Ubuntu Linux

• Under Action, write xdg-open. This will tell Ubuntu to open an Internet address in

your default browser, such as Chrome or Firefox.

MacOS

• Under Action, write open. This will tell MacOS to open an Internet address in your

default browser, such as Safari.

Continue writing the command

Whichever command you used above, you need to tell it which Internet address to open next.

You want it to visit Google, and to search for a phrase automatically.

Usually when you use Google, you enter your search phrase into the Google Search bar.

But in this case, you want your computer to do this for you. The way you tell Google to
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search for something (if you don’t want to use its search bar directly) is by giving your Inter-

net browser the address http://www.google.co.za/search?q=SEARCH_PHRASE,

where SEARCH_PHRASE is what you want to search for. Since we don’t know what phrase to

search for yet, we’ll just enter the first part (without the search phrase).

• In the Action field, write http://www.google.co.za/search?q=. Remember

to add a space after your initial command before writing this in!

Now you want QGIS to tell the browser to tell Google to search for the value of SGADMIN for

any feature that you could click on. Sounds complicated, but QGIS lets you do this easily.

• Select the SGADMIN field.

• Click Insert field:

This will tell QGIS to add the phrase next:

What this means is that QGIS is going to open the browser and send it to the

address http://www.google.co.za/search?q=[% "SGADMIN" %]. But [%

"SGADMIN" %] tells QGIS to use the contents of the SGADMIN field as the phrase to search

for. So if, for example, the farm you clicked on is in the Montagu area, then QGIS is going

to send the browser to http://www.google.co.za/search?q=Montagu, which will

cause the browser to visit Google, which will in turn search for the word “Montagu”.

• If you haven’t done so already, set everything up as explained above.

• Click the Add to action list button. The new action will appear in the list above.

• Click OK on the Layer Properties dialog.
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Now to test the new action!

• With the rural layer active in the Layers list, click on the Run feature action.

• Click on any farm you can see on the map. Your browser will now open, and will au-

tomatically start a Google search for the town that is recorded as that farm’s SGADMIN

value.

Note: If your action doesn’t work, check that everything was entered correctly; typos are
common with this kind of work!

6.4.6 Follow along: Open a Webpage Directly in QGIS

Above, you’ve seen how to open a webpage in an external browser. There are some shortcom-

ings with this approach in that it adds an unknowable dependency – will the end-user have the

software required to execute the action on their system? As you’ve seen, they don’t necessarily

even have the same kind of base command for the same kind of action, if you don’t know which

OS they’ll be using. With some OS versions, the above commands to open the browser might

not work at all. It looks like quite the insurmountable problem.

However, QGIS sits on top of the incredibly powerful and versatile Qt4 library. All that good-

ness is just a heartbeat away with a Python line or two. Also, QGIS actions can be arbitrary,

tokenized (i.e. using variable information based on the contents of a field attribute) Python

commands!

Now you’ll see how to use a python action to show a web page. It’s the same general idea as

opening a site in an external browser, but it requires no browser on the user’s system since it

uses the Qt4 QWebView class (which is a webkit based html widget) to display the content in

a pop up window.

Instead of Google, let’s use Wikipedia this time. So the URL you request will look like this:

http://wikipedia.org/wiki/SEARCH_PHRASE

To create the layer action:

• Open the Layer Properties dialog and head over to the Actions tab.

• Set up a new action using the following properties for the ac-

tion: * Type: Python * Name: Wikipedia * Action (all

on one line): from PyQt4.QtCore import QUrl; from

PyQt4.QtWebKit import QWebView; myWV = QWebView(None);

myWV.load(QUrl(’http://wikipedia.org/wiki/[% "SGADMIN"

%]’)); myWV.show()

There are a couple of things going on here:

• All the python code is in a single line with semi-colons separating commands (instead of

newlines, the usual way of separating Python commands).

• [% "SGADMIN" %] will be replaced by the actual attribute value when the action is

invoked (as before).
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• The code simply creates a new QWebView instance, sets its URL, and then calls

show() on it to make it visible as a window on the user’s desktop.

Note that this is a somewhat contrived example. Python works with semantically significant

indentation, so separating things with semicolons isn’t the best way to write it. So, in the real

world, you’d be more likely to import your logic from a Python module and then call a function

with a field attribute as parameter.

You could equally use the approach to display an image without requiring that the user has a

particular image viewer on their system.

6.4.7 In conclusion

Actions allow you to give your map extra functionality, useful to the end-user who views the

same map in QGIS. Due to the fact that you can use shell commands for any operating system,

as well as Python, the sky’s the limit in terms of the functions you could incorporate!

6.4.8 What’s next?

Now that you’ve done all kinds of vector data creation, you’ll learn how to analyze this data to

solve problems. That’s the topic of the next module.
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